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Overview:

Welcome to the Web+Center Version 8.X installation guide for 64-bit operating systems using 11S 7 or
later.

This install guide is designed to guide you through the installation of Web+Center using screen shots
rather than textual descriptions. Please view the screen shots carefully for individual interface
options (checkboxes, settings, etc) and text box entries.

If you need additional assistance with your installation, please visit our support page on our website at
http://www.inet-sciences.com/support.html for phone, web-based and email based support options.

Basic steps
Install 1S (Internet Information Services) if necessary
2. Download and run webcenter8x.exe
3. Configure default website and create the application pools
4. Configure website properties of
a. Enable Parent Paths
b. Debugging Properties — Send error messages to browser
c. Set limits — Set Max entity limit setting to 20,000,000 for file download
d. Authentication
e. Enable 32-bit (if appropriate)
Set the file security permissions for the Web+Center 8.X folders
Install SQL Server and SQL Server Management Studio (if necessary)
Create the Web+Center SQL database and set defaults (if using SQL Server)
Set the database security account and permissions for the wc80 user
Create the ODBC DSN webcenter80_db for the database
10 Run the installation tests
11. Testing the applications

=
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The first decision you’ll need to make is whether you want to use MS Access or MS SQL Server as the
back-end database. You won’t need an MS Access license since nothing is done using the MS Access
front end and the database drivers/utilities already exist on MS operating systems. However, if you’re
going to use Access, you’ll need to make sure to set 1S up for 32-bit compatibility and you’ll need to
use the 32-bit OBDC administrator since no 64-bit Microsoft Access drivers exist at this time. If you’re
going to use SQL Server as your database, you’ll need to have the SQL Server database and SQL Server
Management Studio installed so you can run SQL Scripts to create the database and tables and set user
permissions. Also, if you’re going to run with 64-bit SQL Server, you’ll need to separately download
and install the 64-bit Mail drivers which can be obtained from our website. Please note that if you
intend to test or run this with an existing 32-bit installation, you’ll need to do the 32-bit installation since
the 32- and 64-bit mailers are incompatible.

So, your options are:
A. MS Access or SQL Server 32-bit database requires 32-bit compatibility mode, 32-bit OBDC
configuration, 32-bit mail drivers (automatically installed during installation)
B. SQL Server 64-bit uses regular IIS setup, 64-bit (the default) OBDC configuration, but separate
installation/registration of 64-bit mail utilities.
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NOTE: All of the components, (database, 11S and ASP mail utilities, ODBC drivers) must all be
32 bits or 64 bits.

STEP 1. Install or Enable 11S 7.X or 8 (if necessary)

a. Log into the server using an account with Administrator privileges.
b. Open Programs and Features in the Control Panel (Start - Control Panel ->Programs
—>Programs and Features).

v + Control Panel » bl |ﬁ_| |_5:‘mrch 2 |

o Name Category E
Ce *anel Home caiziez b 2
« Classic View 3
Coler Date and Default Device Ease of Fingerprint Folder
Management Time Programs Manager Acce.. Sensor Options
: g -3 % €
4 <y o 9 _—t3
Fonts Game Indexing Intel(R) Internet  iSCSIInitiator Java

Controllers Options ~ PROSet/Wir..  Options

W

Keyboard Mail Mouse Metwork and NVIDIA Offline Files Pen and

A

]

Sharing Ce... Contr... Input Devices
People Mear Performance Personaliz.. Phone and Power Printers Problem
Me Informatio... Maodem ... Options Reports a...
- ] ()
~ . — e
m & @ ) Q
. e (= =), =
Programs  REgional and Scannersand  Security SigmaTel Software Sound
and Features A anguage ...  Cameras Center Audio Updates

b @ ® M & =

c. On the left panel, select Turn Windows features on or off.
%4@ + Control Panel + Programs and Features - [ 43| [ search i

il

Uninstall or change a program

To uninstall a program, select it from the list and then click "Uninstall”, "Change”, or "Repair".

| Organize « I Views 4 @
: Publisher Tnstalled |
¥ Turn Windows features on or

off

Install a program from the
network

.

| Currently installed programs
g 1 107 programs installed

I F
h‘u Total size: 548 GB

d. Check the boxes listed below.
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(51 Windows Features (=B ]

Turn Windows features on or off (2]

To turn a feature on, select its check box. To turn a feature off, clear its
check box. A filled box means that only part of the feature is turned on.

Games -
| GroupPolicy Preferences CSE
Indexing Service
= Internet Information Services
FTP Publishing Service
FTP Management Console
FTP Server
= ‘Web Management Tools
= [¥] | 156 Management Compatibility
15 6 Management Console
15 6 Scripting Tools
5 6 WMI Compatibility
IS Metabase and IS 6 configuration compatibility
v II5 Management Console

v
v
v
v

115 Management Scripts and Toals
V| | IS Management Service
S ‘World Wide Web Services
= Application Development Features
V! MET Extensibility
V] ) ASP
v | ASP.NET
cat
V! ISAPI Extensions
V| | ISAPIFilters
v Server-Side Includes
= [ Commaon Http Features
V! Default Document
v Directory Browsing
v HTTP Errors
V! HTTP Redirection
V! Static Content
= Health and Diagnostics
Custom Logging
V! HTTP Logging
Logging Toals
v 0ODBC Legging
v Request Monitor
Tracing
= Performance Features
Http Compression Dynamic
v Static Content Compression
= Security
V! Basic Authentication
Client Certificate Mapping Authentication
v Digest Authentication
15 Client Certificate Mapping Authentication

1P Security
v Request Filtering

URL Authorization
V! Windows Authentication

& Microsoft MET Framework 3.0 -
m

4 3

Cancel

e. Restart your computer

STEP 2. Download webcenter80.exe from the Internet Software Sciences website (www.inet-
sciences.com) and run the installation. You may be able to right-click and select *‘Run as Administrator’
however, IF YOU DO NOT SEE AN INSTALLATION WINDOW, you’ll have to log onto the server as
the Administrator. Note: Do not install this product under the inet-pubs/ wwwroot directory. Installing
this application under the wwwroot will cause some special restrictive directory permissions that make
the default Access database un-updateable unless the directory permissions are changed.

NOTE: There are currently two separate installs — a 32-bit and a 64-bit version. At this time the only
difference between then is that the 32-bit version installs and registers the 32-bit mailer dlI’s.

STEP 3. Configure default website or create new website

a. Open IIS Manager (Start - Settings—>Control Panel-> Administrative Tools—> Internet
Information Services (11S) Manager or Start > All Programs - Admnistrative Tools -
Internet Information Services (11S) Manager) depending on your operating system.
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5 Intemet Information Services (ES] Manager o) |
—~ »
w(,/ [65 » wosoo » &= G @
File View Help
Uil V0500 Home
[ Manage Server
» 195 VoS00 Group by: Area - B v Rl
ASP.NET : St
2 NET Compilation @ NET Globalization °F
(% NET Trust Levels [ Application Settings View Application Pools
[+ Connection Strings 7 Machine Key View Sites
[55: Pages and Controls 2 Providers @ Hep
£ Session State [E SMTP E-mail Online Help
s
B Ase o, Authentication
< Compression | @ Default Document
[ Directory Browsing [&]Error Pages
#|Handler Mappings <% HTTP Redirect
£1|HTTP Response Headers % ISAP] and CGI Restrictions
& ISAPIFilters § Logging
[ MIME Types ‘#{Modules
{33 Output Caching (P Server Certificates
L& Worker Processes
Management
3, Feature Delegation [#]Shared Configuration
[ Fetures View | CortertView
Ready 4.

b. On the Connections list (left panel), expand the tree until ‘Default Web Site “is displayed.

Right-click on Default Web Site and select ‘Add Application’.
NOTE: This is different than 11S 6.0 which uses virtual directories.

| Commections.
« 5 Tve0

a0 San

Ready

. Apglication Pools

i@ Delauk Web Sne

1 internet Informatiem Senvices (E5) Manager
\-_:f':_'J N0 M0N0 &
File  View Halp

0‘# V0500 Home

firoup by: Ares
ASPNET
1 NET Compilation

& Esplore poeis
Lt Pesmissions... pirngs
Eareis
T Al Appheation.
oo AddVirtusl Direetory..
Edit Bindings_
Manage Web See [
Wi Refeeh pings
XK Fermove e Headers
Fename
Swteh 1 Content View ng

=
Maragement
T Feature Delegaticn

Festures Voewe |15 Content View

& NET Globsization
T Appliation Setings
7 Machine ey

& Preiders
AT e mail

42 HTTR Redirect
I 1541 and Ol Restrictions
[HLeggng

H hodutes

G server Cotitreates

7 Shared Configuration

Enter ‘customer80’ in the ‘Alias’ textbox.
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Add Application

Site name:  Default Web Site
Path: !

Alias: Application poel:

customer?0 DefaultAppPool | Select...

Example: sales

Physical path:
C\Program Files\Internet Software Sciences\Web+Cente | . l

Pass-through authentication

Connect as... | | Test Settings...

ok |

Cancel |

For the *Physical Path’, browse to the directory in which you installed Web+Center and

select the CustomerCenter directory below it.

Browse For Folder
Select a directory for the application.
Internet Explorer -
4 Internet Software Sciences
4 Web+Center 7.0
ASPMailer
. BusinessCenter |=
CustomerCenter L
. Database
Documentation
Language
PocketCenter
ProgramFolder
ReservationCenter
| TechCenter
witempfiles -
4 | (1] L3
Make Mew Folder | Ok | Cancel |

Press ‘OK’ and ‘OK” to close the above windows and create the Application.

c. Add the remaining Applications and their physical directories:

APPLICATION/ALIAS PHYSICAL Website/Application
DIRECTORY

Customermobile80 CustomerMobile Smart phone version of
Customer+ Center

TechMobile80 TechMobile Smartphone version of
Tech+Center

Tech80 TechCenter Tech+Center application

Customer80 CustomerCenter Customer+Center
application

Business80 BusinessCenter Business+Center
application

Language80 Language Language directory

Reservation80 ReservationCenter | Reservation+Center
application

wctemp wetempfiles Temporary files

Pocket80 PocketCenter Pocket+Center
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When finished, the right-hand 11S “‘Connections’ menu should look like this (except with
80 instead of 70 under the Default Web Site:

¥ customer7o
Q docs70

@ language?0
P pocket?0

[ Application Settings
_EwMachmeKey

al, Providers

[ SMTP E-mail

4 Connection Strings
7 Pages and Controls
5 Session State

Gjlntemet]nformation Services (IIS) Manager | [E] \@
@\J [@ » NOSI0 » Sites » DefaultWebSite » &~ 5 @~
File View Help
Connections - ; Actions
; @ Default Web Site Home %
|1 & Explore
483 V0500 i Area & Edit Permissions...
2 Application Poals — ——
4.8 Sites ASP.NET
4@ Default Web Site £ NET Compilation @ .NET Globalization
 aspnet_client 52 NET Profile .NET Roles - Sef
& business70 (5B NET Trust Levels A, NET Users View Applications

View Virtual Directories
Manage Web Site A

% Restart

P reservation?0
@ tech?70
B we70temp

s
o ASP Al Authentication B Stop
‘£l Compressicn Browse Web Site

Browse =80 (http)

| @ Default Document
[ Directory Browsing

[EError Pages =
% HTTP Redirect

& ISAPI Filters

#]Handler Mappings
€L/ HTTP Response Headers

Advanced Setfings.

£l Logging 45 MIME Types Configure
‘;ﬁModulas (33 Output Caching ) Limits...
14 SSL Settings @ Help
Online Help
[E Features View |/ Content View
Ready a3

STEP 4. Configure website properties
a. With 11S still open, select “‘default website’ on the left hand ‘Connections’ list, and then double-
click the “ASP’ icon in the center or right-panel under the “11S’ section.
b. Set ‘Enable Parent Paths’ to true and click ‘apply’ in the upper right hand corner.
c. Toenable us to debug any problems, it is necessary for us to know the line number and name of
the offending module. In the center section of IS, expand the ‘Debugging Options’ section by
double-clicking on the “+’. Under *Send Errors to Browser,’ set this value to “True’.
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@ Asp

Display: Friendly Names M

Enable Chunked Encoding True &
Enable HTML Fallback True
Enable Parent Paths True
Limits Properties
Locale ID 0
Restart On Config Change True

B Compilation
= Debugging Properties

m

Calculate Line Numbers True
Catch COM Component Exceptions True
Enable Client-side Debugging False
Enable Log Error Requests True
Enable Server-side Debugging False
Log Errors to NT Log False
Run On End Functions Anonymously True

i viessage occurred on the server when processing the URL. Please ¢
Send Errors To Browser True 7
Debugging '

Properties related to debug settings.

Also, to display line numbers and module names in case of problems on the client’s
browser you’ll need to go to Internet Explorer and uncheck the ‘Show Friendly Errors’
under ‘Internet Properties’ -> ‘Advanced Properties’, -> ‘Browsing’; otherwise only a
‘Internal Error 500" message will appear. If you are using Chrome as your browser:

1. Click the Chrome menu | = | on the browser toolbar.

2. Select Settings.

3. Click Show advanced settings and find the "Privacy" section.

4. Deselect the "Use a web service to help resolve navigation errors™ checkbox to disable the feature.
Select the checkbox to enable it again.

d. Set Limits on file upload. In order to prevent problems when users upload/attach files
to cases, it is often necessary to reset the default limits to something larger. Expand the
‘Limits Properties’ section (still under *‘ASP’) by clicking on the ‘+’ and set the
‘Maximum Requesting Entity Body Limits’” value to something larger (we suggest
20,000,000).
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@ Asp
Display: Friendly Names =
El Behavior il
Code Page 0
Enable Buffering True
Enable Chunked Encoding True
Enable HTML Fallback True
Enable Parent Paths True
= Limits Properties =
Client Connection Test Interval 00:00:03
Maximum Reguesting Entity Body Limit 20000000
Queue Length 3000
Request Queue Time-out 00:00:00
Response Buffering Limit 4194304
Script Time-out 00:01:30 R
Threads Per Processor Limit 25
Locale ID 0
Restart On Config Change True
E Compilation 5
Maximum Requesting Entity Body Limit
Specifies the maximum number of bytes allowed in the entity body of an ASP request.

e. Set Authentication. Click the Default Web Site in the ‘Connections’ left-hand menu.
Double-click “‘Authentication” under IIS.

“ Default Web Site Home

Filter: - @ Go -G Show All | Group by: Area - B~
ASP.NET =
A &4 A L5
Wi & e g > i=® ‘égj
NET .NET .NET Error .NET .NET Profile .NET Roles .NET Trust .NET Users Application
Authorizati.. Compilation  Pages  Globalizati... Levels Settings
1 = {. s e 7 Y
deb] i‘? = E| '._‘23) & 1=
Connection Machine  Pagesand Providers Session SMTP
Strings Key Controls State E-mail
s =
. e _ . e =
2 1 d e a R
ASP EAuthenticati Compressi..  Default Directory Error Pages  Handler HTTP HTTP
E | Document  Browsing Mappings  Redirect Respon...
- . o ==
& EJ| = =i - o= %
ISAPIFilters Logging MIME Types Modules Output Reguest  SSL Settings
Caching Filtering

Management

El

Authentication should be set as below:
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& Internet Information Services (T15) Manager

[E=3EolEx)
&5 ) [@ » w0500 b Sites » DefauitWebSite » i~ 1 @ -
Eile View Help
Connections Actions
r @ Authentication
# Disable
| I\'i(JSUU Group by: No Grouping - Advanced Setfings...
ot Application Pools o =
2.3 Sites Name Status Response Type @ Hep
4 € Default Web Site Anonymous Authentication Enabled Online Help
1 aspnet_client ASP.NET Impersenation Disabled
@ eustomer?0 Basic Authentication Enabled HTTP 401 Challenge
> tech70 Digest Authentication Enabled HTTP 401 Challenge
¥ business70 Forms Authentication Disabled HTTP 302 Login/Redirect
does70 Windows Authentication Enabled HTTP 401 Challenge
language70
pocket?0
(Fwcyltemp
- Preservation?i

Configuration: 'localhost' applicationHost.config , <location path="Default Web Site">

Not all of the above rows may exist, depending on your operating system.

e. If you will be using Access as your back-end database or a 32-bit installation of SQL
Server, you’ll also need to do the following. Select ‘Application Pool’ under
‘Connections’ in the left-hand menu. Under the center section, ‘Application Pools’
select ‘DefaultAppPool’, in the right-hand menu, then select *Advanced Settings...".

Connections

493 NOTCHKA (Notchka'\cynthia)
Application Pools
Ttes
> @ Default Web Site

=)

99 Application Pools

This page lets you view and manage the list of application pools on the server. Application pools are associated with worker
processes, contain one or more applications, and provide isolation among different applications.

Actions

& Add Application Pool...
Set Application Poo
Defaults...

Application Pool Tasks
Filter: ~ [ Go -Gl Show All | Group by: No Grauping - »
Name B Status .NET Fra.. Managed Pi.. Identity Applications B Stop
[ZASPNET 11 Started vi1 Classic ApplicationPoolldentity cr [
m—‘\smned v2.0 Classic ApplicationPoolldentity Ed"f Appl?cation Pool
i} DefaultAppPool )Started v2.0 Integrated ApplicationPoolldentity =) Baslc Set ngs...
L anguagedsstee Started v2.0 Integrated ApplicationPoolldentity N

vanced Settings...
LenarTe

XK Remove

View
@ Help
Online Help

pplications
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On the screen which appears next, change the setting of *‘Enable 32-bit Applications’ to
“True’. DO NOT perform this step if you are running 64-bit SQL Server!

Advanced Settings X
E (General) -
NET Framework Version v2.0
| Enable 32-Bit Applications "rue |Z| =
Managed Pipeline Mode Integrated
Name DefaultAppPoo
Queue Length 1000
Start Automatically True
2 CPU
Limit 0
Limit Action NoAction

Limit Interval (minutes) 5

Processor Affinity Enabled False

Processor Affinity Mask 4294967295
E Process Model 4
Enable 32-Bit Applications
[enable32BitAppOnWin64] If set to true for an application

pool on a 64-bit operating system, the worker process(es)
serving the application pool will be in WOW®64 (Windows ...

o | [ coeet ]

STEP 5. Set the file security permissions for the web+center 8.X folder level and all sub folders to
user group “everyone” full control and remove all other users and break inheritance from above.

The Web+Center application is setup to run as an anonymous web application. To allow the webserver
to allow anonymous users to access the ASP scripts and resources, one must set the file security
permission to “Everyone” full control and remove all other users. To this, carefully follow the steps
below.

a. Navigate to the folder in which you installed Web+Center 8.X.

b. Right mouse click and select the *‘Properties’ menu item for the Web+Center 8.X folder
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« Internet Software Sciences » Web+Center 7.0

» & Bum

Favorite Links MName
J ASPMailer

. BusinessCenter

EI Documents

E; Pictures

1 CustomerCenter
@ Music . Databaze
Maore #» . Documentation
Folders w | i Language
. PocketCent
[+ . Internet Explorer | WO i

i | P Fold
4 | Internet Software Sciences rogramrolder

[ - Web+Center 7

ResenvatinnCenter

d
= 0 InterVideo S
I Intuit Open as Notebook in OneNote
g Java Explore
I+ ) Jumpstart Bpeh

0 ltmoh
= . Mail Enable Share...
> 4 Memeo
Send To 3

0 Microsoft.NET
= . Microsoft Games Cut
. Microsoft Office

Copy
i+ ) Microsoft Works Paite
b L Movie Maker
) 12 items Delete
l Rename
MNew 3

c. Inside of the properties dialog window, first click on the “Security’ tab to change the
permissions.

[ | ‘Web+Center 7.0 Prcperies ﬁ

Secuty | Customize

Object name:  C:\Program FilesIntemet Software Sciences'Web-

GI‘OIJp ar User names:
“ACREATOR OWNER i
53, SYSTEM E

E&Mministmtors {Toshiba-Scott " Administrataors)

22 | lcare (Tachiha-Srntt\l loarsl
1 m |

To change permissions, click Edi.

5 Pemissions for CREATOR
OWNER Allow Deny

Full control i
Modify

Read & execute =
List folder contents

Read

Wirite =

For special pemissions or advanced settings, an:ad
click Advanced. Aeby

Leam about access control and pemissions

[ ok ][ Cance ||

L= = = = —
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c. First, we need to break the set of inherited permissions that come with the Program Files
directory. Click on the *‘Advanced’ button near the bottom.

4 | Advanced Security Settings for Web+Center 7.5 | % | [
v ]
7| | Permissions ‘Auditing | Owner | Effective Permissions‘ L
g To view details of a permission entry, double-click the entry. To modify permissions, click Change Permissions
Object name: C:\Program Files (xB6)\Internet Software Sciences\Web+Center 7.5

| Permission enfries:

Type Name Permission Inherited From Apply Ta

Allow Everyone Full control <notinherited> This folder. subfolders and fil

Allow TrustedInstaller Special CA\Program Files (x86)\  This folder and subfolders
] Allow SYSTEM Full control C:\Program Files (x36)\  This folder, subfolders and fil..
T Allow Administrators (Motchka\Ad Full control C\Program Files (x36)\  This folder, subfolders and fil

Allow Users (Notchka\Users) Read & execute C\Program Files (x36)\  This folder. subfolders and fil..
E Allow CREATOR OWNER Special C:\Program Files (x36)\  Subfolders and files only

Change Permissions...
4 Include inheritable permissions from this object's parent
B
9 Managing permission entries
u
OK ] [ Cancel Apply E

d. Click on the *Change Permissions...” Button

| Advanced Securit_y. Settings for Internet Software Sciences

Permissions
To view or edit details for a permission entry, select the entry and then dick Edit.
Object name: C:\Program Files\Internet Software Sdences
Permission entries:
Type Name Permission Inherited From Apply To
Allow TrustedInstaller Spedal C:\Program Files) This folder and subfolders N
Allow SYSTEM Full control C:\Program Files), This folder, subfolders a...
Allow Administrators (Teshiba-...  Full contral C:\Program Files), This folder, subfolders a...
Allow Users (Toshiba-Scott\Us... Read & execute C:\Program Files), This folder, subfolders a... ]
Allow CREATOR QWMER Special C:\Program Files, Subfolders and files only i
[ adde. [ Edit. || Remowe
Gk ;
Include inheritable permissions from this object's parent
[ | replace all existing inheritable permissions on all descendants with inheritable permissions from this object
Managing permission enfries
[_ QK J ’ Cancel Apply
—— - I - — d
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e. Uncheck the “Include inheritable permissions from this object’s parent’ and click ‘OK’. A
windows Security dialog box will appear that provides the Copy, Remove and Cancel options.
Select the *Remove’ button.

g ™
Windows Security @

Warning: if you proceed. nheritable parentpermssions will no longer
propagate to this object

N

- Click Add to convert and add nhernted parent permissions as explicit
permissions on this object

- Click Remove to remove inherited parentpermissions fromthis object

- Click Cance! if you do notwant to modify inheritance settings at this time.

Add ]| Remaove ‘| Cancel

Advanced Security Settings for Web+Center 7.C @

Permissions |

To view or edit details for a permission entry, select the entry and then dick Edit.

Object name: C:\Program Files\Internet Software Scences\Web+Center 7.0

Permission entries:

No groups or users have permission to access this object. However, the owner of this object can assign -
permissions.

|| Replace all existing inheritable permissions on all descendants with inheritable permissions from this object

Managing permission entries

o) [Cemet ) o

f. Click the *Add...” button. In the “Select User or Group’ dialog box, enter the user “Everyone”
and press the *‘Check Names’ button, then the *OK’ Button.

Select User or Group (- [

Select this object type:

User, Group, or Builtin securty principal Object Types...

From this location:

TosHAScorT

Enter the object name to select (examples):

Evenyone Check Names

o) (o)

Web+Center Version 8.X Windows 7/Server 2012/Server 2008 Install
l4|Page



g. Check the “Full Control” checkbox under ‘Allow’ for the ‘Everyone’ user and press’ OK’.

|, Permission Entry for Web+Center7 C ||
Ohject
Mame: Everyone
Apply to: [This folder, subfolders and files ']
Permissions: Allowe Deny :
Full control s
Traverse folder [ execute file & [
List folder /read data &l
Read attributes ]
Read extended attributes [ |=
Create files [ write data &  l
Create folders [ append data [l
Write attributes [
Write extended attributes B &
Delete subfolders and files il
Delete [l i
A Apply these permissions to objects andfor
containers within this container only
Managing permissions

[ o || conea |

h. Click the ‘Apply’ Button to apply these permissions and then click ‘OK’.

) Advanced Securiy Setingsfor Wb+ Certer7 ) =S

Permissions |

To view or edit details for a permission entry, select the entry and then dick Edit.

Object name: C:\Program Fles\Internet Software Sciences\Web+Center 7.0

Permission entries:

Type Mame Permission Inherited From Apply To
Allow Everyone Full control <not inherited = This folder, subfolders a...
| Add,.. | [ Editiys | | Remove

[T Incude inheritable permissions from this object’s parent

Managing permission entries

oK |[ Cancel ]I Apply

i. Please confirm that your file security settings for the Web+Center folders and all sub folders are
set just the “Everyone” full control and NO other users, similar to the security tab settings
shown below.

Web+Center Version 8.X Windows 7/Server 2012/Server 2008 Install
15|Page



[‘I web+Center 7.0 Properties M
k
Sharing | Securty |Custorni1e

Cbject name:  C:\Program FilesIntemet Software Sciences ' Web-

I:3I'0LI|'.'A Qr User names:

Pemissions for Everyone Allow Dlermy

Full contrel v S |
Modify

Read & execute

List folder contents
Read

For special permissions or advanced settings,
click Advanced. YERG

Leam about access control and permizsions

[l
L]
|
To change permissions, click Edit.
B
]
N
v E
g
J
Write v i3

[ OK ]l Cancel ‘ Bpphy J

STEP 6. Install SQL Server database and SQL Server Management Studio if they are not already
installed (SQL Server only).

STEP 7. Create the Web+Center database (SQL Server only)

Please follow the following steps below to create a Web+Center 80 database. This step does not apply if
you are planning on using MS Access as the back end database.

a. Open SQL Service Management Studio and connect to the appropriate database server.
b. In the Object Explorer area on the left side, right-click ,Databases,, then select ,New Database,.

47 Micioush SQL Serves Management Studio (E=8Eon ===
Fibe Edt Neew Jooh Windew Ceenmuni ty Help
Abiewloey | HDEH R SHLJdBOBET,
Dibject Explorer = 0UX | Object Explorer Detals -
Cannect~ 33 1) @AE & T EM
= L PV0300 (SGL Server 2.0.308% X
- oI J Databases

¥ [ System Databases
# [ Database Snapshots V0500 Dtabiases. 3 memis)

Harme
2 Syttern Databases

[ Databaze Snapshots
J webcenter

[ 50L Server Agent (Agent P desabled)
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c. Enter webcenter80 into the ‘Database name’ textbox. Click OK to create the initial blank

database.
| § MNew Database = 8 S
Selecta page I . ,
Script Hel
1 | 2 General st~ [ Hep E
|#5 Options -
| | Filegroups Database name: WebCenter80
Owner: <default= D
=
Database files: E
Logical Name File Type  Filegroup Initial Size (MB)  Autogrowth
WebCenterB0  Data PRIMARY By 1 MB. unrestricted growth
WebCenterf... Log Mot Applicable 1 By 10 percent, unrestricted growt] | £
£
o
Connection
Server:
NOTCHKANSQLEXPRESS
Connection:
Notchka®cyrthia
&4 View connection properties
B
Progress 1
Ready 4 i b
[ ok J[ Camed | ||
L

d. Next, the database tables need to be created. From the menu bar at the top of the SQL Server
Management Studio, select File >Open —>File »>navigate to C:\program files\Internet
Software Sciences\Web+Center 8.X \databases \Createwebcenter8X.sql. After you select the
script to run, Management Studio may prompt you to connect to the server, so select the
appropriate server and press the Connect button.
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I — = ——
7~ — @ E; B

Open File ——— -
Lock in: | Database Izl @ ~A X i B ~Toolsw
Name Date maodified Type Size
- & ConvertedBusiness.mdb
Desktop | createwebcenter?0.sql

__ CreateWebCenter80 (1).5q]
. CreateWebCenterl,cql
l | LoadWC70Defaults.sql

My Projects || LoadwcT5defaults.sgl
| LoadwcB0defaults.sgl
Es.hl 2 webcentersl.mdb

- 2 webcenter7.mdb
My Computer | E]webcenter70DOWNLOADED.mdb
) webcenter75.mdb
2 webcentergd.mdb

B
o)

e. IMPORTANT: Select the database where you want to run this query. In the upper left hand
portion of the SQL Server Management Studio next to the ‘EXEUTE’ button, you will you see a
drop down list of databases. Select the webcenter80 database.

]
6
:

42 Migresoft SQL Server Management Studio
Eile  Edt Meew  Query Project  Iook  Wedew Cemmunty  Help

QHewluey ) DD R YA LHdI BPEBREF,

% %3 (et ) S(fEa)v s DR 2% Pan oo s 2 eE,
Okject Explorer = 3 % IVOS0Owebrenter_ewebeentenbilagl | Object Exploces Detais | s b
Conrect~ | & : —
! - = - eateWebCenter 70 sql seript =
5 LS V0500 {SQL Server 5.0.3068 - 13) Tse this script to build the Web+Center 7.0 SQL SFRVER database Tables *** W
=== Version date: February 15, 2011
¥ ¥ id, N 1=
d, H° =
¥ d, H* b
i
[B) SGL Server Agert [Agent XPs disabled)
d, ¥
d, H* 1=
¥ d, H* b
d, W
NISOOBOSPY (52 webcerterkl C0OO000 Orows |
Feady Lnl Coll Chl NS

f. Click on the ! Execute button to create all of the tables and database settings. After the script has
run, in the Messages window it should display a message indicating “Command(s) completed

successfully”.
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= oS

L Micresoft SQL Server Management Studic
e Edt Mew Queyy Project Jook Window Commun 2y Help
Qbowlory O DDR RSN EEI DEIRE ST,

2 13| webcentetd | BEmate v u 82|45 D DED S S ke,
Dbject Explorer -0 X = Detads - %
Connect | ) | . =

8 TVOS00 (SQU Server 909066 - £4)
- [ Datsbases
4 [ Systern Databases
1 [ Databese Snapshots
5 [ webcentest
# [ Datakuse Disgrams
5 (3 Tables
% [ Views
5 3 Synenyms
+ [ Pregrammability
§ [ Service Broker

3 [ Storage

ces
(B SGL Server Agent (Aqent XPs dissbled)

& Ouery emecuted successhily. MOS0 EOSPY)  sa (D) webcerterfl 000000 Orows

inl Cols Cha NS

Feady

g. Nextyou’ll need to run a second SQL script to populate the database with some default data. Select
File >Open > File > navigate to C:\program files\Internet Software Sciences\Web+Center 8.X
\databases - LoadWC8XDefaults.sql. It will prompt you to connect to the server, so select the
appropriate server and press thg Connect button.

| Open File - - @éj
Look in: . Database EI @ ~ X i E ~Took~
MNarme Date modified Type Size
1 ! ConvertedBusiness.mdb
Desktop | createwebcenterf0.sql
| CreateWebCenter80 (1).5ql
. CreateWebCenter80.sql
J _ LoadWCT70Defaults.sql
My Projects || LoadwcT5defaults.sql
LoadwcB0defaults.zqgl

| webcenterﬁﬂ.mdb
[A”L‘m webcenter?t].mdb

My Computer | E]webcenter70DOWNLOADED.mdb
webcenter?E.mdb
B webcentergd.mdb

B
5

h. IMPORTANT: Select the database where you want to run this query. In the upper left hand
portion of the SQL Server Management next to the ‘Execute’ button you will you see a drop-
down list of databases. Select the webcenter80 database.
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[(= Microsoft SQU Server Management Studio e =

&

‘ &3

File Edit View Query Project Tools Window Community Help

S Nl

=1 New Query T == - M
am - (oeone D #1257 %0 B

Object Explorer -3 x NOTCHKA\SQLEXPR...wcB0defaults.sql | NOTCHKA\SQLEXP... SQLQuery2.sq1" | not connected - SQLQueryl.sql” | Summary
Connect - | &2 ]
= | webcenterg0
(3 Database Diagrams
= 3 Tables
[ System Tables

WC20Defaults.sgl

0 Load Default Values for SQL*Server/SQL 2000

2005/SQL 2008 Database

This module adds t

=1 dbo.AdditionalCustomerCaseAssignments
=1 dbo.AssetAssignment
[ dbo.AssetCategories
5 dbo.AssetCategoryltems
=1 dbo.AssetGroup
[ dbo.AssetGroupValues
= dbo.Assets
1 dbo.BConfiguration
=1 dbo.Case_Text_Field_Labels
@ I dbo.cases
=1 dbo.categories
21 dbo.Companies
= = dbo.Configuration
A Columns
3 Keys
23 Constraints
3 Triggers

tion to the database for initial startup. This script must be run
application to operable.

PT after you are starting using the database

m

vou must first run CreateWebce: 0.sql script.

(23 Statistics
= dbo.CustomerAccountManager
= dbo.Cu otes
= dbo.Cu
@ 3 dbo.CustomerTechAssignment

| %

[ Indexes /13 cMB v what about default directories, logos, ete

i. Click on the ! Execute button to create all of the tables and database settings. In the Messages
window it should display a message indicating “xx Row(s) affected”.

4 Microsatt SQL Server Management Shsdio. (= o]
File Edit View Query Project Took Window Communi ity Help
Atewuey ) BE5H B SHAEDI DABE R,
B webcenterd = | ¥ Execute o el AR |
Oibyect Faglarer - 0 % -
Connect~ | 8 =4
i TVOS00 (341 Server 90,3068 - sa)
_d Databases
% [ System Databeses
& [ Detabase Snapibets
2 5L Server Agent (Agent KPs dinbled)
& Query executed successiully. MOS0 (S05P2 sa(53) wetcerteril 000000 Orows
Feady inl Cell Chl NS

This completes the creation of the Webcenter80 database tables and initializes some of the
columns with default data.

STEP 8. Set the database security account and permissions for the wc80 user (SQL Server only).
You must create a user account for the webcenter80 database. The Web+Center software accesses the

database using SQL Server Authentication and requires a SQL Server user account. Create a SQL user
account with username of “wc80” and a password of “wc80pass”.
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a. To add this user account for your webcenter80 database, in the SQL Server Studio Manager under
Object Explorer, navigate to Security and then Right Mouse Click and select the New... Login menu
option.

e In the Login name text box, enter “wc80”.

¢ For Authentication area, select the SQL Server Authentication radio button and enter the
password of: “wc80pass”.

¢ Uncheck Enforce password policy and Enforce password expliration
¢ Change the default database to webcenter80.

|3 Login Properties - wcB0 .- ‘ . . B = (o2 |-
Select a page ‘ . =
A General ; SRS U RE

1 Server Foles

_'%"' User Mapping Login name: wcBl Search
& Securables
1A Status

Password: LTI T YT T Y Y

Corfirm password: T ITTI T Y IY

[T] Erforce password policy

Certificate name:

Connection

Server: Key name:
MNOTCHKANSGLEXPRESS
Connection: Default database: [webcenter&ﬂ vl
Motchka'cynthia Defautt language: [English v]
Progress
Ready

ok | [ Cancel

b. Click on ‘User mapping’. Select the webcenter80 database in the top part of the screen. Check all of
the boxes in the database role membership box at the bottom. Press the ‘OK” button to save this user
profile.

Web+Center Version 8.X Windows 7/Server 2012/Server 2008 Install
22|Page



|j Login Properties - wcB0 SIS %
Selectapage [ i
Script + Hel
'| 1% General S sewt ~ [jrep
| Server Roles
1 _ﬁ,‘ User Mapping Users mapped to this login:
_ﬁ,‘ Securables Map Database User Default Schema -
& status [ Elchlers
0 master —
[ model
[ msdb
El  SBCC
0 tempdb 3
[[]  webcenterGlbb
webcenter70
wcBl E] | 4
Database role membership for: webcenter80
Connection
[¥] db_accessadmin
Server: [¥] db_backupoperatar
NOTCHKANSQLEXPRESS [¥] db_datareader
Connection: [] db_datawriter
Netchkea'cyrthia db_ddladmin
| db_denydatareader
%&ﬂ View connection properties db:dematawriter
[¥] db_owner
Progress [Fl| db_securityadmin
[¥] public
Ready
[ ok ][ Cancel
L A

STEP 9. Create the ODBC DSN for the database.

a. Start the OBDC Administrator
NOTE: 64-Bit OS differences: If you are installing Web+Center on a 64-bit version of the
operating system and if you want to connect to the Access 32 bit driver, you must run the 32 bit

version of the Data Sources ODBC driver setup application.

For 32-bit setups: The 32-bit version of the ODBC database sources must be run it by using the
START... RUN command with the file path:

C:\Windows\SyswOW64\odbcad32.exe

= Run S
Type the name of a program, folder, document, or
— Internet resource, and Windows will open it for you.
Open: c\windows\syswowbdodbcad32.exe ~[ M
(]
[ OK J l Cancel l l Browse... ]
i
L — i — - o =]
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For 64-bit installations (SQL Server 64-bit) you can start the ODBC Administrator directly:
Navigate to and double click Administrative Tools: Start - Settings—> Control Panel->
Administrative Tools - Data Sources (OBDC) or Start > Administrative Tools > Data Sources

(OBDC) if using Windows 7.

F=mEcn <=}

—~—— - >
Uu |E€‘. » Control Panel » Administrative Tools

: Organize

Views ~ [H Open (& Burn

@,‘ Backup and Restore Center
¥ BitLocker Drive Encryption
'ﬁ Default Programs
@.‘ Ease of Access Center

4 Fonts
L% Network and Sharing Center

R RS, 0

Shortcut Size: 1.64 KB

>

-

|‘f | ‘ Search

v MName Date modified Type Size
!l:‘ T (A Computer Management  11/16/2008 8:53 PM  Shortcut
= ﬁData Sources (ODBC) 11/2/2006 7:52 AM Shortcut
B Prctures (5] Event Viewer 11/2/2006 7:53 AM  Shortcut
B Music {8 Internet Information S...  11/23/20089:37 AM  Shartcut

Mare » @ﬁlnternet Information 5...  11/18/2008 7:21 AM  Shortcut
Enliars ~ | [#iSCSIInitiator 11/2/2006 7:53 AM  Shortcut
éb Local Security Policy 11/16/2008 8:54 PM  Shortcut

‘ﬁ?zz:t::mnh - [#Memory Diagnostics T... 11/2/2006 7:51 AM  Shortcut
] Public | | @M\crosoﬁ: .NET Frame... 11/19/2008 9:08 PM  Shortcut

/8 Computer E| E}?Prmt Management 11/2/2006 7:54 AM  Shortcut
=-'!_ Network ‘ ‘ @Rehablhty and Perform... 11/16/2008 &53 PM  Shortcut
Contiol Banal | [# Services 11/16/2008 8:54 PM  Shortcut
B A e it T @ Systern Configuration 11/2/2006 7:51 AM  Shortcut

Ei AutoPlay (&) Task Scheduler 11/2/2006 7:53 AM  Shortcut
@Wmdnws Firewall with ... 11/16/2008 8:54 PM  Shortcut

4

f—— Data Sources (ODBC) Date modified: 11/2/2006 7:52 AM

Date created: 11/2/2006 7:52 AM

m

b. Inthe ODBC Data Source administrator, click on the ‘System DSN’ tab.

;ﬁ ODBC Data Source Administrator

B

| User DSN | System DSN | File DSN | Drivers | Tracing I Connection Pooling I About |

System Data Sources:

Name Driver

Add.

=

=1 on this machine, including NT services.

An ODBC System data source stores information about how to connect to
the indicated data provider. A System data source is visible to all users

Co)

Cancel

c. Inside the System DSN tab, click the ‘Add...” button to add a new system DSN.
d. From this point, the paths for SQL Server and Access diverge.
MS ACCESS STEPS:

Inside the “Create New Data Source’ window, select ‘Microsoft Access Driver (*.mdb)’ and
press the ‘Finish’ button.
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Create New Data Source

=)

Select a driver for which you want to set up a data source.

Name

r: : i Driver do Microsoft dBase (™.dbf)
_EE_ Driver do Microsoft Excel(”xds)

Driver do Microsoft Paradox {".db )

Driver para o Microsoft Visual FoxFPro

Microsoft Access Driver ("mdb)
Microsoft Access Driver ("mdb, ~.accdb)

oW

4 [t |

\ o
E
€L
£
1
Microsoft Access dBASE Driver (*.dbf, " ndx, “mdx) 1
£
1

-

NOTE: This driver won’t show up if you are using the 64-bit version of the ODBC

Administrator.

Enter ‘WEBCENTERS80_DB’ into the ‘Data Source Name’ field and enter “Web+Center
Database’ in the ‘Description’ field. Press the “Select...” button.

.. ™ T . .

ODEC Microsoft Access Setup

7

[E3

Data Source Name: WebCenter80_DB
Description: Web+Center databasze (Access)

Database

Databasze: C:'..‘\Database'webcenter80mdb

[ Select... ] [ Create... ] [ Repair... ] [Compad...

I System Database

@ MNone

di| ) Database:

Sy=tem Databasze...

oK

Cancel

elp

Advanced...

Options>>

Navigate to the webcenter80.mdb file, select the webcenter80.mdb file and press the ‘OK’
button. Typically this file has been installed in the directory:

c:\Program Files\Internet Software Sciences\Web+Center 8.X\Database\
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i - =)
Select Database
Database Name Directaries:
webcenter§0.mdb o hdatabase -
ConvertedBusiness mdt - [=rcn -
webcenterbl mdb P Fil
webcenter /0 mdb EE‘ lzgm; 5::; 4cB6) Help
webcenter FODOWMNLD o =L
L webcerter75 mdb (== Web+Center 8.0 [F] Read Orly
webcenter80.mdb = Database _ | FExcusve
List Files of Type: Drrives:
[.Pv.ccess Databases {".mi v] Hc -
b o

Press the *OK’ button to complete your ODBC DSN connection.

=

i

’
5] QODEC Data Source Administrator
—

User DSN | System DSN | File DSN | Drivers | Tracing | Connection Pooling | About |

System Data Sources:

Name Driver Add...
webcenter70_DB SQL Server

— Remaove
WebCenter80_DB Microsoft Access Driver ["mdb) -
¥ireme Sample Database 2008 Microsoft Access Driver ["mdb)
4 T | *

the indicated data provider. A System data source is visible to all users

m An QODBC System data source stores information about how to connect to
on this machine, including NT services.

@

[ ok || camcel | ool -

]

Press ‘OK’ to close this OBDC Administrator.

SOL Server STEPS:

Inside the ‘Create New Data Source” window, select *SQL Server’ and press the “Finish’
button.
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Create New Data Source

Select a driver for which you want to set up a data source.

Name =

W
E, | Microsoft Paradox-Treiber {".db ) €

: 1 J Microsoft Text Driver ("td; *.csv) £
——— Microsoft Text-Treiber (" td: *csv) 4
Microsoft Visual FoxPro Driver 1
Microsoft Visual FoxPro-Treiber 1
SQL Native Client Y
¢

4| m e

P T

< Back Cancel

Enter ‘WEBCENTERS80_DB’ into the ‘Data Source Name’ field and enter “Web+Center
Database’ (or some other description) in the ‘Description’ field, select the SQL Server server
that contains the database, (or ‘(local)’ if on the same server) and Press the ‘Next’ button.

Create a New Data Source to SQL Server @

This wizard will help you create an ODBC data source that you can use to
connect to SQL Server.

E‘ What 7ame do you want tc use to refer to the data source?
.L"?.-l Mame- WebCenter80_DB
1

How co you want to descrize the data source?

Description:  Web+Certer 8.0 databasz (Sql Server)

Which SQL Server do you want to connect to?

Server: -
|
| |
[ Fnish | Net> | | Cacel | [ Hep |

On the next screen, select the “With SQL Server authentication...” option, check the ‘Connect
to SQL Server to obtain default settings....” checkbox, enter the login and password for the
Web+Center database (wc80, wc80pass), and press the “Next’ button:
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- =% IS
P |'\

Create a New Data Source to SQL Server

| £

How should SCQL Server verify the authenticity of the login 1D?

() With Windows NT authentication using the network login 1D.

%; @ With SQL Server authentication using a login 10 and passwond

= entered by the user.

To change the networlk librany used to communicate with SQL Server,
click Client Configuration.

Client Configuration...

Connect to SQL Server to obtain default settings for the
additional corfiguration options.

Login ID: wcBD

Password: eeeessss

| <Back | MNet> || Cancel | | Hep |

On the next screen, check the checkbox before ‘Change the default database to:’, select
‘WebCenter80’, and press the ‘Next” button.

Create a New Data Source to SQL Server EE_|

T

Change the default database to:
webcenterdD -

% [7] Attach database filename:

Create temporary stored procedures for prepared SGL statements and
drop the stored procedures:

(@ Only when you disconnect.
When you disconnect and as appropriate while you are
connected.

Use ANSI quoted identifiers.

Use ANSI nulls, paddings and wamings.

Use the failover SAL Server if the primany SAL Server is not
available.

| <Back | Net> || Cancel | [ Hep |

On the next screen, you can leave the defaults alone and press the ‘Finish’ button:
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Create a New Data Source to SQL Server z %

|"|Change the language of SAL Sarver system messages to:

English -

|:i Use strong encryption for data
'_{ Perform translation for character data
[]Use regional setings when outputting currency, numbers, dates and imes.
[: Save long running queries to the log file:
C\Users\cynthia\AppData\Local\Temp\QUERY.LOG Browse
Long query tme (milhseconds): 30000

[]Log GDBC driver statistics to the log file:
C\Users\cynthia\AppData\Local\Temp\STATS LOG Browse

1 | < Back “ Finish } | Cancel ‘ | Help ‘
| - — — —

On the next screen, press the ‘Test Data Source’ button and make sure it connects successfully,
then click *OK’ to complete your ODBC DSN connection.

S0 Server ODBC Data Source Test [3]
Test Results
Microsoft SQL Server ODEC Driver Version 06.00.6001
Running connectivity tests...
Attempting connection
Connection established
Verifying option settings

Disconnecting from server

TESTS COMPLETED SUCCESSFULLY!

STEP 10. Run the tests
Launch your favorite browser on the server where you are doing the configuration and enter the

URL of:

http://localhost/tech8X/installtest.ntm (Replace X with the version you used to set up the application
directories in 11S)

You should see the test page shown below. Click on the ‘Please Click Here — Installtest.asp’.
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http://localhost/tech8X/installtest.htm

Webh+Center | nternet
Version 7.0 S)oftware
161 2911 - Itermed Seftemre Solences S ciences

Web+Center Installation Debugging Tools
Preliminary Test:
This module (Installtest.htm) is the first system check and will test if "Active Server Pages” (ASP) is enabled on your system.

Please click on the link below - if you then receive an immediate failure report or the following screen does not show the same logo at the top as displayed above, then
it is an indication that ASP has not been activated.

Please click here - Installtest asp

On the installtest.asp page, run through each of the 10 tests and configurations starting with number 1
and lastly click the TechCenter Application Login button at the end of the tests.

NOTE: If you are running 64-bit Internet Information Server (I1S), then you will need to download and
install a special 64-bit version of our licensed ASP Mailers (See instructions in Appendix A). The ASP
email test will not successfully complete until these ASP mailer 64-bit dlls are installed and registered.

STEP 11: Testing the applications

Use the following URL’s to test the Web+Center Suite of applications

where <YourHostName> is either:
e your local machine name
e Your domain name (www.mycompany.com) or resolvable domain name
e Static or dynamic IP address
e The word “localhost” if browsing on the same machine as the server

Tech+Center comes configured with 2 default tech staff accounts with the following levels of

permissions:
Tech Password | Access Level
Username
CSS-1000 Config Configurator (highest)
CSS-1003 Tech Read/Write tech level

These are automatically available with the initial seed database. They should only be used to access the
system initially and they should be immediately modified or deleted once other tech accounts are
created. Refer to the Web+Center Users Guide on how to edit or add Tech+Center accounts. Use these
for all Applications except Customer+Center and Customer+Maobile.

Tech+Center http:// <Y ourHostName>/tech80/

Customer+Center http://<Y ourHostName>/customer80/

Reservation+Center | http://<YourHostName>/reservation80/

Business+Center http://<YourHostName>/business80/

Pocket+Center http://<YourHostName>/pocket80/ To view or test the
Pocket+Center on a full-
size screen interface, use
the special Pocket+Center
test interface page by
accessing:
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http://www.mycompany.com/

http://<YourHostName>/po

cket8X/testpocket.htm.
This has been largely
supplanted by
Tech+Mobile.
Mobile+Center http://<Y ourHostName>/CustomerMobile80/
Tech+Mobile http://<YourHostName>/TechMobile80/

Appendix A: Installing 64-bit special ASP Mailers

If you are installing Web+Center Version 8.0 on a 64-bit IIS platform, you must install the latest 64-bit
versions of our ASP mailer and our POP mail reader from Email Architech to be compatible.

Step 1: First obtain the 64-bit version of mailer dllI’s. These are available from our website at
http://www.inet-sciences.com/Version764bit.zip. This zip contains two files — Anpop.dll and
Aosmtp.dll. Copy these versions into the AspMailer directory of the Web+Center directory tree,
replacing the existing 32-bit versions.

Step 2: Unregister the 32-bit versions that came with the original 32-bit installation and register the one
you just downloaded with the regsvr32 dll registry tool.

Note: On a 64-bit version of a Windows operating system, there are two versions of Regsv32.exe. The
64-bit one (which is the default) is in c:\windows\System32 and the 32-bit one is in
c:\windows\SysWOW64 and is 32-bit (which seems counter-intuitive). The 32-bit DLL must be
registered with the 32-bit version of regsvr32 , while the 64-bit version must be registered with the 64-
bit version.

RegSvr32.exe has the following command-line options:
Regsvr32 [/u] [/n] [/i[:cmdline]] dlIname

e.g., c:\windows\syswow64\regsvr32 c:\program files (x86)\web+center 8.x\ASPMailer/anpop.dll
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